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Section 1 General information

1.1 Use of hazard information

D A N G E R
 

Indicates a potentially or imminently hazardous situation which, if not avoided, will result in death
or serious injury.

W A R N I N G
 

Indicates a potentially or imminently hazardous situation which, if not avoided, could result in
death or serious injury.

C A U T I O N
 

Indicates a potentially hazardous situation that may result in minor or moderate injury.

N O T I C E
 

Indicates a situation which, if not avoided, may cause damage to the instrument. Information that
requires special emphasis.

1.2 Product overview
Flo-Ware is a software system for communication with supported instruments. The
system uses a modular format, where "plug-in" file drivers are installed for each
instrument type that is used.
Additionally, data can be processed from supported instruments at the same time. For
example, data can be plotted from the Flo-Tote system and from the Flo-Dar system in
the same chart or text report.
Flo-Ware options:

• Data charts
• Data reports
• Data reconstruction and edit functions
• International language support
• Custom formats for data reports

File Driver options:

• International language support
• Communications with devices directly or via modem
• Original file-type reading
• Data calculations
• Other instrument services

Compatible programs:

• Report Designer—the Report Designer is used to change the design of text reports.
The reports can be saved as templates for easy reuse.

• Instrument-specific drivers—these "plug-ins" are designed for each instrument type
that operates with Flo-Ware. After the driver is installed, Flo-Ware will automatically
communicate with and record data from the associated instrument.

Table 1  Instrument-specific drivers

Driver Instrument

FL900 Series FL900 Series Logger and attached sensors or modules

Flo-Dar Marsh McBirney Logger and Flo-Station with a Flo-Dar Sensor
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Table 1  Instrument-specific drivers (continued)

Driver Instrument

Flo-Tote 3 Marsh McBirney Logger and Flo-Station wtih a Flo-Tote 3 Sensor

Flo-Tote Marsh McBirney Logger and Flo-Station wtih a Flo-Tote Sensor

Sigma Sigma 910/911 Logger with a Submerged Area/Velocity Sensor

1.3 PC requirements
The computer must have the following minimum requirements:

• Windows® 2000 or XP operating system
• Pentium class processor or equivalent, 90 MHz
• 16 MB RAM
• Video adapter card for 1024 x 768, 96 dpi resolution, 16-bit color

General information

4



Section 2 Installation

2.1 Install the files
Two installations are necessary:

• Flo-Ware—contains the main application, the Language Editor and the Report
Designer.

• File Drivers—must be installed for communication with devices.

1. Find the link for the Flo-Ware 4 installation from the website or from the CD:

• Go to http://www.hachflow.com/p_soft_floware_down.html.
• Put the CD in the computer. If the main window does not open automatically, find

and open the startcd.exe file on the CD.
2. Follow the on-screen instructions to install the software. When the installation is

complete, a Flo-Ware shortcut icon is shown on the desktop.
3. Find and install the Flo-Ware Help File. Follow the on-screen instructions to install the

file.
4. Find and install the File Driver for each instrument that is used. Follow the on-screen

instructions to install the file.
5. Install any associated files that are shown for the instrument, such as a USB driver. If

the USB driver install wizard does not appear, go to C:\Program Files\Flo-Ware
\FL9xx\USB Driver.

2.2 Install updates
The application and drivers are updated regularly for continued improvement. Install the
updated files for best results.

1. Make sure that the computer is connected to the internet.
2. Open Flo-Ware and click on the HELP button. The Help, About window opens.
3. Find the version of the application and drivers that are in use.
4. Click on the CHECK FOR UPDATES button. An internet browser opens and the

download center is shown.
5. Compare the version number of the installation files on the download page to the

version of the application and drivers that are in use.
6. If a newer file is available, close the application and install the updated files.
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Section 3 Operation

3.1 User interface
Main window
Double-click the FLO-WARE icon on the desktop to open the main window (Figure 1).

Figure 1  Main window

1   Themes panel—measurement channels 5   Balloon help—descriptions of icons and links

2   Options panel—language options and device drivers 6   Program style—color and style options for Flo-Ware

3   View panel—main view and data views 7   Main view—changes with the selected menu

4   Main toolbar—icons shown in all windows 8   Main-view tasks—links for basic tasks and information

3.2 Raw data
The Raw Data view shows the data or project file in a spreadsheet. The columns
correspond to the themes that are shown in the Themes panel. The maximum number of
records is limited only by the computer memory.
Navigation in the Raw Data view is similar to navigation in common spreadsheet
software. Use the arrow keys on the computer keyboard to move up, down, left or right.
Use hot keys such as Ctrl + End to move the cursor to the last cell in the spreadsheet.
Use Ctrl + Home to move the cursor to the first cell in the spreadsheet.
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3.2.1 Edit data
Data can be adjusted in the raw data view to change incorrect values. For example, if a
value for the level measurement indicates 0 volume, the corresponding velocity value
should also be 0. If the velocity value is not 0, a velocity value of 0 can be entered.

1. Click to select a data cell in the raw data view.
2. Use a method to change the values:

Option Description

Manual Use the computer keyboard to change the value. Any calculated values, such
as flow, are automatically recalculated. For example, if the velocity value is
doubled, the flow is automatically recalculated.

Find/Replace Use the FIND/REPLACE button to search for data and replace the value.

Calculator Select one or more data cells and and select add, subtract, multiply or divide
from the Operator field on the toolbar. Enter a value and click the
RECALCULATE SPREADSHEET button.
Note: To highlight multiple cells, click in a data cell and drag down.
Alternatively, click in a data cell, press the shift key and click in another cell.

3.2.2 Export data
Data can be saved in a .txt or .csv file format for use in common applications such as
Microsoft® Excel® spreadsheet software.

1. Open a data or project file in the Raw Data view.
2. Click the EXPORT button from the toolbar of the Raw Data view. The Export window

opens.

Operation
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3. To change the date and time range, click on the start time or end time that is shown.
The Date/Time window opens. Select a new date and time range and click OK.

4. Select a Data Interval. The intervals in the exported data file can be different from the
intervals in the raw data file. For example, the raw data file can have 15 minute
intervals and the exported data can have hourly or daily intervals.

5. Click EXPORT. The Save Export File As window opens.
6. Enter a file name and location.
7. Select either the tabbed text (.txt) or comma separated values (.csv) file format and

click SAVE.

3.2.3 Open data or project files
A data file is created whenever data is transferred from an instrument to the computer.
Open these files to view and analyze the data. When data files are opened in Flo-Ware, a
project file is automatically created.
The project file contains the charts, text reports, themes and analysis for the data. Save
the project to retain the changes that were made. When the project file is opened at a
later date, the project opens up at the point where it was last saved.

1. Click on the FILE OPEN button on the main toolbar. The Open File window opens
(Figure 2).

2. In the Type section, select a file type:

• Flo-Ware Project Files—previously-opened files that were saved as a project.
• Instrument Files—available for an instrument if the file driver for that instrument

was installed.
3. In the Look In section, click BROWSE to select the folder where the data files are

located. Once a path is selected, it will be available from the drop-down list.
4. In the File Name section, click to highlight the data file to open. To highlight more

than one file, press and hold the shift key and then click additional files.
5. If a project is currently open, the Import Options section is shown. Select whether to

start a new project or import the data into the current project.

Operation
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Figure 2  Open file window

1   Options for highlighted files 4   File type (dependent on installed file drivers)

2   Data or project files 5   Options for multiple files

3   Path to file location on PC or network 6   Options for checked files

6. Click OK. The Data Interval window opens.
7. Select the time span and data interval.

Option Description

Start Time The start time of the data file is shown initially. A different date and time can
be selected.

End Time The end time of the data file is shown initially. A different date and time can be
selected.

Data Interval The data interval that is set for the instrument is shown initially. A different
interval can be selected and the data will be averaged.
Note: Some intervals are not compatible with the intervals set for the
instrument. For example, if the instrument is set to record in 3- or 15-minute
intervals, the 1- and 5-minute intervals in Flo-Ware are not available.

Operation
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8. Click OK. The file, if a single file and a new project, opens in the Raw data view.
9. If the file is imported into the current project, or if multiple files are opened, the Theme

Data window opens. Select Import (side by side) or Append (string the data together)
and click OK.

Option Description

Import Data A side-by-side presentation is useful when the data from many different sites
is plotted in one project. This presentation is useful, for example, when
comparing upstream and downstream sites within the same project.

Append Data Data files from the same site can be appended to create long continuous
projects that are several months or several years long. Make sure to append
data only from the same site.

The data file will open in the Raw data view. Flo-Ware copies the selected data file(s)
and imports it into the project, leaving the original raw data file unchanged and intact
for archival purposes.

3.2.3.1 Change file properties
In the Open File window, the properties of a data file can be changed. For example, if the
wrong year was assigned to a connected flow meter during installation, the start date for
the file can be changed. Each supported instrument has a unique set of file properties.
Note: The file properties cannot be changed for project files.

1. Click the FILE OPEN button and select the file type and path in the Open File
window.

2. Highlight the file name and click Properties. The File Properties window opens.
3. For FL900 Series files, select a port/sensor.
4. Click in one of the fields, edit the information and click OK.

3.2.3.2 Make a new data file
The user can make a new data file from one or more highlighted data files. This can be
useful when several data files exist for one month of data, for example. The first data file
may not start exactly on the first day of the month at 0:00 hours, and the last file may not
end exactly on the last day of the month at 24:00 hours. These data files can be
combined into one data file that is exactly one month long.
Note: Some instruments that are supported by Flo-Ware allow the user to select the exact span of
data. In this case, a data file can be created with the exact span that is needed.

1. Click the FILE OPEN button and select the file type and path in the Open File
window.

2. Highlight one or more file names and click Create data file. The Select Data Span
window opens.
Note: To open multiple files, highlight the first file, then hold down the Ctrl or Shift key and
highlight additional files.

3. Select or enter the start date and time, the end date and time and click OK. The Save
File window opens.

4. Enter a name for the file and click Save.

3.2.3.3 Delete files
Data and project files can be deleted if necessary.

1. Click the FILE OPEN button and select the file type and path in the Open File
window.

2. Highlight the file name to delete and click Delete. A confirmation window opens.
3. Click YES to delete the file.

Operation
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3.2.3.4 Copy files to a new location
A data or project file can be copied and pasted to a different location on the computer or
network.

1. Click the FILE OPEN button and select the file type and path in the Open File
window.

2. Click the check box next to one or more file names.
3. Click Copy Checked files to. Select the new location on the computer or network

and click OK. The files are copied and pasted to the new location.

3.3 Themes
Themes are shown as data columns in the Raw Data view. Each theme name is also
shown in the Themes panel (refer to Figure 1 on page 7).
The available themes correspond to the channels that were selected for logging during
the site setup of the associated instrument. For example, the level and velocity themes
are shown when a Flo-Tote 3 sensor is set up with level and velocity logging. A flow
theme is also calculated and added.
The check boxes in the themes panel allow the user to show or remove a theme in charts
and text reports. Themes are always shown in the raw data view. To change the order of
a theme, click and drag the theme up or down in the Themes panel.

3.3.1 Set up themes
Themes can be shown in a chart with different colors and attributes such as line width or
style. For example, the velocity theme can have one color and the level theme can have a
different color.

1. Right-click a theme name from the Themes panel and select Theme Setup. The
Properties window for the theme opens.

2. Change the attributes that are shown on each of the tabs and click OK.

Option Description

General Changes the basic attributes of a theme such as the name and units. The
available attributes change with the type of chart that is selected in the View
panel.

Marks Changes the appearance of the marks or labels on a chart that shows
individual data points. The changes affect only the theme that is selected on
the General tab.

Line, Bar or
Area

Changes the appearance of the theme in a line, bar or area, pie or scatter
chart. The available attributes change with the theme that is selected on the
General tab.

3.3.2 Edit site information
The user can view and edit information about the site that is associated with the data file.
Each supported instrument has a unique set of site information attributes.
Edit the attributes when information was entered incorrectly during setup. For example, if
an incorrect pipe diameter were entered, the flow data in the site file will be incorrect. The
pipe diameter can be changed in the Site Information window. The flow data is then
calculated correctly in the site file.

1. Open the site file.
2. Right-click the theme name from the Themes panel.
3. Select Site Information. The Site Information window opens.
4. Edit the site information and click OK.

Operation
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Note: Refer to the help system for the associated instrument for more details about Site
Information.

3.3.3 Delete a theme
A theme can be removed from a project at any time.

1. Right-click the theme name to be removed from the Themes panel.
2. Select Delete Theme. A confirmation window opens.
3. Click YES to delete the theme.

3.3.4 Make a custom theme
A Custom Theme adds a new column in the raw data view for user data such as
infiltration/inflow, temperature, pH or maximum allowable flow.

1. Click Custom Theme in the Options view and select New. The Data Interval window
opens.

2. Enter the start time and end time. If the project is new, select the data interval.
Note: If in an existing project, the interval that was set when the first file was added to the
project is used for the data interval.

3. Click OK. The Custom Unit Editor window opens.
4. Define the units of measure for the chart and report labels:

• Standard unit of measurement—enter the units and abbreviation.
• Unit of measurement for totals—enter the units and abbreviation to use for totals.

If the standard unit involves a rate, select the rate of measurement.
5. Click OK. The Custom Properties window opens.
6. Enter a name for the custom theme.
7. Make selections on the General, Marks and Attributes tabs to define all of the

attributes for the new custom theme. Click OK.
8. To add data, select the Raw Data view. Type the data in the new column or paste

data from a program such as Microsoft Excel spreadsheet software.
All charts and text reports will reflect the selections that were made for the custom
theme.

3.4 Charts
To view data in a chart, open a data file and click Chart in the View panel.

3.4.1 About charts
Charts allow the user to see the data in a graphical format. Charts can show trends,
anomalies, maximums, minimums and totals. Data can be shown in 4 different types of
charts:

• Combination—shows data as a line, a bar or an area. One theme can be shown as
a data line, for example, and another theme can be shown as a bar

• Bar—shows data as vertical bars. The summary type for the theme must be set to
show total values. The total values are calculated based on the data interval. Each
theme is shown as a portion of each bar.

• Pie—shows data as a area. The summary type for the theme must be set to show
total values. The total values are calculated based on the data interval. Each theme is
shown as a section of the pie. The pie chart should only be used with the same type
of data, for example flow data.

• Scatter plot—shows data as (x, y) data pairs for two different themes. The first two
checked themes are shown on the chart. The first checked theme is shown on the x-
axis and the second checked theme is shown on the y-axis. To show the data for

Operation
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different themes, select or deselect the check box next to the theme name or change
the order of the themes.

Use the buttons on the chart toolbar to navigate in the chart. To move the chart to the
right or to the left, click on the PAN button, then right-click on the chart and drag the
mouse to the left or right. The ZOOM IN and ZOOM OUT buttons allow the user to
increase or decrease the amount of data that is shown in the chart view. The chart length
can be increased up to 1 year.
Charts can have multiple pages. The page navigator in the main window shows the total
number of pages and the page number that is currently shown. Click the right or left
arrows to go forward or back, or enter a number in the edit box and press ENTER on the
computer keyboard.

3.4.2 Set up charts
The appearance of charts can be configured for attributes such as background color,
titles, legends and 3-dimensional effects. The changes affect all of the themes in a
project. After a chart is configured, the settings can be saved to a template for use with
other data files.

1. Open a data or project file.
2. Click Chart from the View panel.
3. Select a chart type (Combination, Bar, Pie or Scatter).
4. Click the CHART SETUP button from the Chart toolbar. The Chart Setup window

opens.
5. Change the attributes that are shown on each of the tabs and click OK.

Option Description

General Changes the data span per chart page and sets 3D effects.

Background Changes the background color of the chart and adds a background image or
frame.

Legend Changes the location and style of the legend.

Axes Changes the settings for any axis of the chart. Select one of the axes from the
left panel and then change the attributes for that axis.

Titles Adds up to 9 different titles in a chart. Select one of the options from the left
panel and then change the title attributes for that option.

Walls Change the appearance the 3-dimensional walls that make up a 3D chart. The
3D Charting option must be enabled in the General tab of the Chart Setup
window. Select one of the walls from the left panel and then change the
attributes for that wall.

3.4.2.1 Change the data range
The data span for the chart is shown in the Report Settings panel. The data span, chart
length and data interval can be changed and the updates can then be seen in the chart
view. Changes that are made to the span, chart length and data interval will change the
number of chart pages.

Operation
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1. Select the check box next to Custom Data Span in the Report Settings panel. The
start and end dates are shown.

2. To change the date and time range, click on the start time or end time. The
Date/Time window opens. Select a new date and time range and click OK.

3. Select a chart length to be shown on each page of the chart.
4. Select the data interval to be shown. The chart view is updated to show the changes.

3.4.2.2 Make a template for charts
The settings that are made in the Chart Setup window can be saved as a template file for
use with other data files.

1. Click on the CHART TEMPLATE button on the Chart toolbar. The Template Set
Options window opens.

2. Select Save Template Set and click Next. The Save Template Set Options window
opens.

3. Select one of the options:

• Save as Default Template—the current chart settings are used automatically
each time a chart is viewed. Click Finish and YES.

• Save Template Set to File—the current chart settings can be saved and loaded
into a project at any time. Click Next. Enter a file name and description for the
new template. Click Finish.

3.4.2.3 Use a chart template
A chart template can be used as the default setup for charts, or it can be imported at any
time.

1. Click on the CHART TEMPLATE button on the Chart toolbar. The Template Set
Options window opens.

2. Select Load Template Set and click Next. The Load Template Set Options window
opens.

3. Select one of the options:

• Load Default Template Set—use the default template to make a new chart. Click
Finish.

• Load Template Set from File—use a previously saved template for the current
project. Click Next. Select a template file from the drop-down box. Click Finish.

Operation
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3.4.3 Print a chart
A paper copy of a chart can be made from a local or network printer.

1. From the View panel, select Chart.
2. Click the PRINT button. The Print window opens.
3. Select the printer, the number of pages to be printed and make any necessary

changes to the properties. Click OK. The chart is sent to the printer.

3.5 Reports
Reports of raw data can be shown for different time intervals or as a summary of
maximum, minimum, average and total values.

3.5.1 Make a report
Use the Text Report toolbar to make a text report.

1. Open a data or project file.
2. From the View panel, select Text Reports.
3. Select a report type from the Available Reports drop-down list on the Text Report

toolbar. The report is shown in the view window. Use the page navigator on the main
toolbar to view additional pages.
Note: After a report type is selected, it is available in the Installed Reports list.

4. To add or remove a theme (column), go to the Themes panel and select or deselect a
theme.

5. To change the order of themes, go to the Themes panel and click and drag the theme
name up or down.

6. To change the date range:

a. Go to the Report Settings panel.
b. Select the check box next to Custom Data Span. The start and end dates and

times are shown.
c. Click on the start or the end date and time. The Date/Time window opens.
d. Select a new date and time and click OK. The report will update and show the

new date and time.

3.5.2 Print a report
A paper copy of a report can be made from a local or network printer.

1. Open a text report.
2. Click the PRINT button. The Print window opens.
3. Select the printer, the number of pages to be printed and make any necessary

changes to the properties. Click OK. The report is sent to the printer.

3.6 Data reconstruction
The data reconstruction workspace gives the user the flexibility to analyze data and, if
necessary, repair or reconstruct the data. The example in this section describes the
removal of an error in the velocity theme from a flow meter.

Operation
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3.6.1 About data reconstruction
When a set of data suddenly shows a large change from a stable pattern, the data should
be examined to find the cause for the change. As an example, imagine that the flow and
velocity themes suddenly become erratic and go to very low values for approximately
1 day. This change can be due to a true decrease in the flow, or to a condition such as
debris that collected on the sensor.
Upon examination, the level theme shows a stable pattern for this day. If the flow actually
did decrease, the level data is expected to decrease also. The conclusion can then be
made that the velocity data has an error on that day.
This error can be removed with the reconstruct option. The span of inaccurate data can
be replaced with a span of data that is known to be accurate. The result will be more
accurate data, better flow balances and a higher level of statistical confidence.
The line chart or the scatter plot can be used to remove errors from most data files. The
line chart is used to repair sections of data (Use a reconstruction table on page 17). The
scatter plot can be used to reconstruct an entire set of data (Use the scatter plot
on page 18).

3.6.2 Use a reconstruction table
The example that follows shows the removal of an error in the velocity theme based on
the level data. The level data is referred to as the Base Theme. Before reconstruction,
find a span of data that is considered to be accurate and that follows a noticeable pattern.

1. Open the data or project file and select View>Chart. Select the Combination Chart
from the toolbar.

2. Right-click the Velocity theme in the Themes panel and select Reconstruct. The
Reconstruct Velocity window opens.

3. Select the Level theme from the drop-down box as the basis for the reconstruction
and click OK. The Data Reconstruct panel is shown.

4. In the Data Reconstruct panel, select Table > New. The Reconstruction Table
Properties window opens.
Note: To edit a reconstruction table that was previously saved from the same site, select Table
> Open.

5. Update the options as follows:

• Decimal Precision—set the decimal precision for the 2 themes. The higher the
precision for the base theme, the longer it will take to populate the table with
data.

• Base Theme Data Range—select the approximate minimum and maximum
values of good data for the base theme (as seen in the line chart).

• Notes—enter a comment about the site for future use.
6. Click OK. A data reconstruction table is added to the Data Reconstruct panel.

The left column of the table shows the Base Theme. The right column of the table
shows the theme to be reconstructed.

7. In the chart, select a span of data that is known to be accurate. First, left-click the
start of the data, then right-click the end of the data span. The selected data for both
themes will change color. Make sure that the selected span includes only accurate
data.
Note: If the Pan or Zoom buttons are enabled, the data cannot be selected.

8. In the Data Reconstruct panel, select Table > Populate with Data. The velocity data
will be added to the velocity column. Some of the data cells will be empty.

9. Use one of the options that follow to fill in the empty data cells:

• Select additional data spans to populate the table with more data.
• Enter a reasonable value for the velocity using the keyboard.
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• Interpolate over blank cells: click and drag to highlight data from above the first
empty data cell to below the last empty data cell. Select Edit > Interpolate. The
table is updated with the linear interpolated data. The start and end cells are used
as reference points.

• Change to the Scatter Plot view and click in the scatter plot where the data
should likely be (refer to Use the scatter plot on page 18).

10. Select a span of inaccurate data in the chart. First, left-click the start of the data, then
right-click the end of the inaccurate data span. The selected data for both themes will
change color. Make sure that the selected span includes the data to be
reconstructed.
Note: If the Pan or Zoom buttons are enabled, the data cannot be selected.

11. In the Data Reconstruct panel, select Table > Reconstruct. The theme is updated to
show the correction (Figure 3).

12. Select Table > Save to save the table. Enter a file name and location to store the file.
Note: This table can be used for future data reconstruction at the same site.

13. Close the Data Reconstruct panel to exit the reconstruction session.
Note: To reverse the reconstruction, select the Raw Data view and click the undo button.

Figure 3  Data before and after reconstruction

1   Valid data 2   Incorrect data 3   Repaired data

3.6.3 Use the scatter plot
Use the scatter plot when it is necessary to reconstruct the entire set of data. First, select
a span of accurate data with the line chart to populate the reconstruction table. Then
change to the scatter plot view to reconstruct the data.

1. Complete 1 to 9 to in Use a reconstruction table on page 17.
2. Click on the SCATTER PLOT button. The data from the reconstruction table is shown

in the scatter plot in a different color from the rest of the data set (Figure 4).
3. If necessary, edit the data in the reconstruction table. The data points on the scatter

plot are updated to show the new values.
4. In the Data Reconstruct panel, select Table > Reconstruct. The entire set of data is

updated to match the table data (Figure 4).
5. Save the reconstruction file and close the Data Reconstruct panel.

Note: To reverse the reconstruction, select the Raw Data view and click the UNDO button.
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Figure 4  Data before and after reconstruction
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Section 4 Device communication

C A U T I O N
 

Refer to the safety information in the user manual for the device before any connections are made
to the device.

When the driver for a device is installed, Flo-Ware can communicate directly with the
device for various purposes such as data collection and site configuration.

4.1 FL900 series logger
4.1.1 Initial setup

4.1.1.1 Install the Flo-Ware FL900 Driver
Note: During driver installation this message will appear: "The following device has not passed the
Windows Logo testing to verify its compatibility with Windows. Continuing your installation of this
software may impair the correct operation of your system either immediately or in the future.
Microsoft strongly recommends that you stop this installation now and contact the hardware vendor
for software that has passed Windows Logo testing." Hach engineers have fully tested this product
and determined that it is compatible with Windows. Press the "Continue anyway" button to finish the
installation.

Pre-requisite: Before the FL900 logger is attached to a computer, make sure that Flo-
Ware is installed on the computer.
The FL900 Series Driver must be installed on the PC to communicate with the logger.

1. Find the link for the FL900 Series Driver on the Flo-Ware CD or from the website
http://www.hachflow.com/p_soft_floware_down.html

2. Click on the link and run the application. The install wizard starts.
3. Follow the on-screen instructions to install the driver. Use the recommended settings.

4.1.1.2 Attach the logger to the computer

Pre-requisite: Make sure that the FL900 driver is installed on the computer.
Connect only one logger to the computer.

1. Attach the logger to the computer (Figure 5).
2. When a USB cable is attached for the first time, the Found New Hardware wizard

opens. Run the new hardware wizard to install the USB driver for the logger. When
finished, the message “Your new hardware is installed and ready to use” is shown. In
the event the wizard does not run or the install fails, contact Hach Flow Tech Support
to assist with trouble shooting your specific operating system.
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Figure 5  Attach the logger to a computer

4.1.1.3 Attach a sensor or external devices to the logger

Pre-requisite: Make sure that the connection status is offline.

W A R N I N G
 

Sensor Hazardous Locations and RF Exposure Hazards. Some sensors have RF radiation
exposure hazards and are used in explosive atmospheres. See sensor manual warnings and
instructions before connecting a sensor to the logger.

The number of sensors that can attach to the logger varies with the model of the logger.
Some sensors must attach to an external module that is used as an interface between the
sensor and the logger. Figure 7 shows the AV9000 Area Velocity Analyzer module on the
side of the logger and the connection to a submerged area/velocity sensor.

1. If the sensor cable has connectors on both ends, attach the cable to the sensor first.
2. Attach the sensor (or module) to any SENSOR port on the logger (Figure 6 or 

Figure 7). Tighten the connector by hand.
Note: For rain gauges, attach the sensor to the RAIN connector.

3. If the sensor uses an external module, attach the module to the logger, then attach
the sensor to the module (Figure 7).

4. If the sensor cable has a desiccant hub, align the desiccant hub vertically and make
sure that the air port points down (Figure 6).
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Figure 6  Attach a sensor to the logger

Figure 7  Attach a sensor to an external module

4.1.2 User interface and navigation

4.1.2.1 Driver window description
From the Options panel in Flo-Ware, select FL900 Series>Communications. The
FL900 Series Driver window opens (Figure 8). The FL900 Series Driver window has tabs
and buttons to complete tasks or access menus. The connection status is shown on the
bottom bar (Connection status on page 24).
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Figure 8  FL900 Series Driver window

1   Menu tabs 5   Connection status—online or offline

2   Menu options 6   Read/Write buttons (online only)

3   Toolbar buttons 7   Connection details

4   Main section 8   Load/Save/Clear buttons

4.1.2.2 Connection status
The connection status shows when a communication session is open:

• Online—a communication session with the logger is open. Any attached sensors are
shown in the driver window. The user can download and view data from the logger
and write a program to the logger.

• Offline—the FL900 driver is not connected to the logger. The user can open a site file
or make a logger program for later use.

4.1.2.3 Toolbar

The toolbar buttons are always shown, but some buttons are enabled only when the
connection status is online or offline.
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Table 2  FL900 Series Driver toolbar

Connect—starts a communication session with
the logger.

Download since last—downloads only the data
that was logged since the previous download.

Disconnect—stops the communication session
with the logger.

Open a file—opens a site file or sensor
diagnostics file from the default file path.

Global settings—opens the settings window
where various default settings such as file paths
can be changed.

Help—opens the help window.

Download all data—downloads all data from the logger.

4.1.2.4 Menu tabs
Use the tabs to access the various menu options:

• Programming—sets all of the user-adjustable parameters in the logger.
• Data—allows the user to view data (tabular and graph) and get sample history from a

site file that has been downloaded from the logger.
• Diagnostics—contains the event log, alarm log, current status of the logger and real-

time modem and sensor diagnostics.
• Utilities—contains tools such as firmware updates.

4.1.3 Connect to the logger
When a communications session is started, the connection status changes from offline to
online.

1. In the FL900 Series Driver window, click the CONNECT button. The Communications
window opens.

2. Select the computer port (COM or USB) from the drop-down list. For COM ports,
select the communications protocol for the computer.
Note: When a USB cable is attached to the computer, a virtual serial port (e.g. USB:COM3) is
assigned.

3. Click OK. The driver reads the logger program and looks for sensors that are
specified in the program.
A Sensor Mismatch message is shown for the following situations:

• The current logger program does not include an attached sensor
• The current logger program includes a sensor that is not attached
• The current logger program includes a sensor that is attached to an incorrect port

4. If the Sensor Mismatch message is shown, select one of the options and click OK:

• Use existing logger program—ignore the attached sensors and import the
program from the logger.

• Create new logger program based on detected sensors—include the attached
sensors in a new program. The new program can then be written to the logger.
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4.1.4 Make a logger program
The logger must have a program to specify all of the necessary parameters for data
collection. The program can be made when the logger is online or offline. When made
offline, the program is saved to a file and later written to the logger.
The logger can have only one program. When a new program is written to the logger, the
previous program is erased.

1. From the Options panel in Flo-Ware, select FL900 Series>Communications to open
the driver window.

2. Start a communication session.
3. Click the Programming tab.
4. Complete each menu option:

Option Description

Site information on page 27 Specifies general settings such as the model number,
site ID, time zone, memory mode and GPS coordinates.

Communications settings—
remote on page 28

Contains the remote communication settings for the
logger.

Communications settings—local
on page 27

Contains the local communication settings for the
logger.

Datalog setup on page 29 Specifies which measurements will be recorded, what
values trigger an alarm and what actions will occur
during an alarm condition.

Flo-Dar setup—Cal Wizard
on page 30

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration wizard.

Flo-Dar setup—manual
on page 31

Sets the sensor units, flow channel geometry and the
sensor calibration manually.

Flo-Tote setup—Cal Wizard
on page 36

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration wizard.

Flo-Tote setup—manual
on page 36

Sets the sensor units, flow channel geometry and the
sensor calibration manually.

Ultrasonic setup—Cal Wizard
on page 37

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration wizard.

Ultrasonic setup—manual
on page 39

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration manually.
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Option Description

AV9000 Analyzer Module setup—
Cal Wizard on page 41

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration wizard.

AV9000 Analyzer Module setup—
manual on page 42

Sets the sensor units, flow channel geometry and the
sensor calibration manually.

IM9001 module setup
on page 44

Contains the communication settings for a Sigma Flow
Meter.

Set up alarms on page 45 Sets the system alarms and specifies the address or
number for email or text message notification.

Set sampler options on page 46 Specifies the time interval that triggers the sampler to
collect samples.

4.1.4.1 Site information
The site information menu contains the identification information for the site.

1. Click the Programming tab.
2. Complete the information in the Site Information menu:

Option Description

Model Number If online, the model number is selected automatically. If offline, select the
model number of the logger that will be programmed.

Site Identification Enter a unique name for the site (mandatory, maximum 16 characters).
When telemetry is used for remote monitoring, a site repository is made
on the server with this name.

Site Location The optional location description (maximum 30 characters).

Time Zone Select the correct time zone for the site. When telemetry is used, the
server uses this time zone to synchronize the clock.

Memory Mode The memory mode specifies how the datalog operates when the memory
becomes full. Wrap (default): the oldest data points are deleted as new
data is added. Slate: data collection stops.

Site Notes Click the note icon to enter optional comments. Click the save icon to
save the comments. The note file is saved as a .sn file in the default file
path location.

GPS Coordinates Enter the GPS coordinates for the site (optional). Use Datum WGS84 as
the reference location and the format that is shown for Latitude and
Longitude. When telemetry is used, these coordinates are shown on the
map in FSDATA.

4.1.4.2 Communications settings—local
Local settings apply when the logger is connected to a computer with a communications
cable. These settings are stored in the logger. When a communication session is started,
the settings in the computer must be the same as the settings in the logger. The default
local settings are sufficient for most applications. Change the settings only for specific
communication requirements such as connection to a third-party device.

1. Click the Programming tab.
2. Click on the Communications menu.
3. Change any of the options:

Option Description

Modbus Address The address that is used for network communication with the logger
(default address: 2).

Device communication

27



Option Description

Baud Rate The baud rate assigned to the logger.

Parity Even, odd or none.

Protocol Modbus RTU (default) or Modbus ASCII.

4.1.4.3 Communications settings—remote
A modem can be used to transmit data to a server or to send email or text messages
from the logger. The modem can be for wireless or landline (dialup) communication.
When a GPRS wireless modem is used, the user must first install the SIM card from the
mobile provider (refer to the documentation for the logger).
For connection to the internet, the user must first configure the server for the instrument
and get the Security Verification Code (SVC). Refer to the user manual for the
FL900 logger for more information.

1. Click the Programming tab.
2. Click on the Communications menu. If online, most of the settings are completed

automatically.
3. Change any of the options for the modem:

Option Description

Enable Modem Makes the modem active. If the modem is not used, deselect this
option to save battery power.

Modem Type Selects the type of modem (refer to the label on the logger).
Options: GPRS, Verizon, Sprint, Dialup.

Modem Frequency GPRS only—sets the modem frequency to be used. Options: 850,
900E, 1800, 1900, 850/1900 (North America), 900E/1800 (EU),
900E/1900 MHz.

Network Provider Wireless only—selects the mobile provider. Options: EU Mobistar
1, EU Mobistar 2, US AT&T, US TMobile.

Access Point Name GPRS only—the access point name is entered automatically when
the network provider is selected.

Username If the network provider supplied a user name and password, enter
the information.

Password If the network provider supplied a user name and password, enter
the information.

Programming Code Verizon or Sprint only—this information is supplied by the network
provider.

Mobile Station ID Verizon or Sprint only—this information is supplied by the network
provider.

Mobile Data Number Verizon or Sprint only—this information is supplied by the network
provider.

Primary dial number Dialup only—this information is supplied by the internet service
provider.

Secondary dial
number

Dialup only—this information is supplied by the internet service
provider.

4. Change any of the options for the server:

Option Description

Server IP Address Internet server address, supplied by the manufacturer.

Port Number Internet connection information, supplied by the manufacturer.
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Option Description

Primary Call Interval The frequency that the logger calls the server, not to exceed the
logging interval. Options: 5, 6, 10, 12, 15, 30, 60 minutes; 2, 3, 4,
6, 12, 24 hours.

Secondary Call Interval The frequency that the logger calls the server during an alarm
condition. Options: 5, 6, 10, 12, 15, 30, 60 minutes; 2, 3, 4, 6, 12,
24 hours.

SMS to E-mail Gateway GPRS only—completed automatically when the provider is
selected.

SMS Service Center GPRS only—completed automatically after the provider is
selected.

Server Verification
Code

The customer-specific ID that connects an instrument to the
customer account during telemetry.

4.1.4.4 Datalog setup
Use the datalog setup menu to specify which channels will be recorded in the datalog. A
channel can be a reading from an attached sensor, the battery voltage from the logger or
a statistical value based on a sensor reading. A channel must be selected before any
data can be saved. A maximum of 16 channels can be selected.
Note: If channels are added to or removed from an existing program, all data in the logger will be
erased. Be sure to download the data from the logger to a safe location before the modified
program is written to the logger.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. If offline, click on the Datalog Setup menu. Select the sensor(s) from the drop-down
list in the Port Assignments section that agree with the sensor and port configurations
on the logger.

3. Click on the Datalog Setup menu.
4. Select the channels to be logged in the Select Datalog Channels section:

a. Expand the tree for the Logger channel group. The Power Supply channel is
always shown in this group. Logging the power supply value is useful in order to
know when the batteries should be replaced. A low value alarm can be set to
send an email or SMS when a specified voltage value is reached. If the logger
contains a port for a rain gauge, the Rain channel is also shown. To include a
Logger channel in the datalog, select the check box next to the channel name.

b. Expand the tree for each Port[1 ](Sensor Name) channel group to view the
available channels for the sensor.

c. To include a Sensor channel in the datalog, select the check box next to the
channel name. The log channel count increases each time a channel is selected.
Note: For loggers with multiple sensor ports, the port number is added to the channel
name. For example, Velocity 3 is the velocity channel name for sensor port 3.

5. To set the logging interval for a channel group:
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a. Click on the channel group name, for example Port1 (Flo-Dar). The logging
intervals are shown.

b. Select the interval from the drop-down list. The primary logging interval is used
for normal operation. The secondary logging interval is used during alarm
conditions.
Note: The logging interval cannot be set for an individual sensor channel.

6. To change the units for a channel, click on the channel name. The units are shown.
Select the units from the drop-down list.

4.1.4.5 Flo-Dar setup—Cal Wizard
The sensor can be configured and calibrated with the calibration wizard. The sensor must
be installed in the process and the connection status must be online for calibration.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. Click on Sensor Port[1] (sensor name).
3. Select the units in the Unit Preferences section. These units can be different from the

logged units that are specified in the Datalog Setup menu.
4. Click on the CAL WIZARD button. The Calibration Wizard window opens.
5. Select the options on each screen and click NEXT:

Option Description

Number of
samples

The number of times the sensor is sampled for the calibration
measurements (1, 2 or 3).

Flow parameters The shape and dimensions of the flow channel (circular, rectangular,
trapezoidal or U-shaped).

Ultrasonic
transducer

The level (depth) sensor that is used during non-surcharge conditions
(standard or extended range).

Surcharge velocity The SVS sensor for velocity measurements during surcharge
conditions (yes, no. If yes, select the sensor port where the SVS is
attached).

Sensor height The distance from the bottom of the flow channel to the top of the
sensor frame (direct—measured by user or indirect—measured by
sensor. If indirect, the user must enter the liquid level after the
measurement has been sampled from the sensor).

Calibration screen The calibration measurements are taken.

Actual level The liquid level (depth) measured by the user in the flow channel.

Actual velocity The user can measure the velocity with a different instrument and enter
the value (optional).

6. When the Calibration Complete screen is shown, click FINISH. The Calibration
Wizard window closes.
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Note: The Calibration Complete screen shows the values that were entered by the user and
the values that were measured by the sensor. If the values are different, the calibration
adjustment value or multiplier is shown.

7. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date and time settings of the server.

4.1.4.6 Flo-Dar setup—manual
The Calibration Wizard is the easiest method to set up the sensor. Use the manual setup
for odd-shaped flow channels or to adjust some of the calibration parameters. The sensor
must be installed in the process and the connection status must be online for calibration.
Be sure to complete the level calibration before the velocity calibration.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. Click on Sensor Port[1] (sensor name).
3. Select the units in the Unit Preferences section. These units can be different from the

logged units that are specified in the Datalog Setup menu.
4. Click on the Flow Settings tab and select the shape of the flow channel.
5. Enter the dimensions of the flow channel. Be sure to enter the correct depth for non-

circular channels.
6. If the flow channel is odd-shaped, a table is shown. A cross-section of the shape can

be divided into parts and the area of the parts can be entered into the table.
7. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date and time settings of the server.

8. If an SVS sensor if used, complete the following steps:

a. Click on the Surcharge Settings tab.
b. Select the Use SVS Sensor check box.
c. Select the sensor port on the logger where the SVS is attached.
d. Change any of the SVS settings if necessary:

Option Description

Reversed SVS Sensor Select if the Flo-Dar sensor is installed in the reverse
direction.

Conductivity Trigger The conductivity value that starts the Flo-Dar surcharge
mode (secondary trigger).

Distance Turn-On The distance that starts the SVS operation (primary trigger).
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Option Description

Distance Switchover The distance that starts the Flo-Dar surcharge mode (primary
trigger).

Surcharge Level Trigger The surcharge level that starts the SVS operation (secondary
trigger).

SVS Velocity Multiplier The multiplier that is used to adjust the SVS measurements.

Note: After the SVS port number is specified in the Flo-Dar setup, the menus are the
same for the Sensor Port[1] (Flo-Dar) and the Sensor Port[2] (SVS) screens.

If an SVS is not used, make sure that the Use SVS Sensor check box is not
selected.

4.1.4.6.1 Calibrate the Flo-Dar surcharge level
Calibration of the surcharge level sensor is usually not necessary when the auto
calibration function is enabled. The value for the surcharge level should be zero during
normal flow conditions. If the value is high or drifts, replace the desiccant cartridge.

1. Click on the Advanced Settings tab in the Sensor Port[1] (FloDar) menu and click
CALIBRATE. The Surcharge Level Calibration window opens.

2. Click TAKE SAMPLE. The sensor measures the surcharge level. When complete,
the value is shown in the Sensor field.

3. If the measured depth is not zero (or the measured value), enter zero (or the
measured value) in the Actual field. The offset is calculated and shown. The offset is
used to adjust the measured value to the correct value.

4. Click OK.
5. Change any of the surcharge level settings if necessary:

Option Description

Level Calibration Shows the current value for the level calibration.

Stability Variance Changes the required stability for auto calibration.

Trigger Count Changes the required number of stable readings for auto calibration.
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Option Description

Auto Range Min Negative value limit for auto calibration.

Auto Range Max Positive value limit for auto calibration.

6. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date and time settings of the server.

The level calibration is complete.
Note: The data in the Quality Parameters section should not be changed unless recommended by
technical support.

4.1.4.6.2 Calibrate the Flo-Dar ultrasonic level sensor
Calibrations must be done at the location where the sensor is installed. The sensor does
not need to be calibrated again unless it is moved.

1. Click on the General Settings tab.
2. In the Flo-Dar U-Sonic Level Settings section, select the Transducer Type (standard

or extended range).
3. If the sensor height is known, enter the value in the sensor height field. The sensor

height is the distance from the bottom of the flow channel to the top of the sensor
frame. If the sensor height is not known, do the following:

a. Click ENTER. The U-Sonic Height window opens.
b. Click TAKE SAMPLE. The sensor measures the distance to the liquid surface.
c. In the Measured Level field, enter the depth of the liquid in the channel. The

sensor height is then calculated and shown in the Sensor Height field.

4. Click OK. The U-Sonic Height window closes.
5. If there is sediment in the flow channel, enter the amount in the Sediment field.
6. Click the CALIBRATE button. The U-Sonic Level Calibration window opens.
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7. Click TAKE SAMPLE. The sensor measures the distance to the liquid surface and
uses the sensor height information to calculate the liquid level. After approximately
45 seconds, the level measurement is shown.

8. If the measured depth is different, enter the measured value in the Actual field. The
offset is calculated and shown. The offset is used to adjust the measured value to the
correct value.

9. Click OK.
10. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date and time settings of the server.

The level calibration is complete.
4.1.4.6.3 Calibrate the Flo-Dar velocity

Calibrations must be done at the location where the sensor is installed. The sensor does
not need to be calibrated again unless it is moved. Be sure to complete the level
calibration before the velocity calibration is started.

1. Click on the General Settings tab.
2. In the FloDar Velocity Settings section, select a Velocity Method:

• Mean Vel—use for circular flow channels.
• Vel Multiplier—use for non-circular flow channels.

3. If the velocity and flow are known, enter a site multiplier.

a. Click the GENERATE button. The Velocity Multiplier window opens.
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b. Click TAKE SAMPLE. After approximately 45 seconds, the measured velocity is
shown.

c. In the Actual Velocity field, enter the known velocity. The multiplier value is
calculated and the value is shown in the Multiplier field.

d. Click OK.
e. Repeat steps a–d to make sure the velocity is stable.

4. If the average velocity is not known, a velocity profile should be completed.

a. Click on the Diagnostics tab and then the Current Status menu.
b. Record several real-time velocity readings from the Channel Info section.
c. Calculate the average of the real-time velocity readings.
d. Complete a velocity profile. The Open Channel Profiling Handbook is a good

reference on velocity profiling.
e. After the velocity profile is completed, repeat steps a–c.
f. Compare the average velocity from the real-time readings to the velocity profile.
g. Calculate the multiplier to convert the Flo-Dar velocity to the profiled velocity.
h. Click on the Programming tab and go to the Flo-Dar sensor port menu.
i. Enter the multiplier in the Site Multiplier field in the General Settings tab.

5. Change any of the velocity settings if necessary:

Option Description

Site Multiplier Adjusts the Flo-Dar velocity to the profiled or known value.

Min FFT Limit Narrows the processing window of the velocity measurement.

Max FFT Limit Narrows the processing window of the velocity measurement.

Min Velocity Cutout Forces the velocity to a substitute value when the measurement is
outside of a user-specified range.

Max Velocity Cutout Forces the velocity to a substitute value when the measurement is
outside of a user-specified range.

6. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date and time settings of the server.
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The velocity calibration is complete.

4.1.4.7 Flo-Tote setup—Cal Wizard
The sensor can be configured and calibrated with the calibration wizard. The sensor must
be installed in the process and the connection status must be online for calibration. If the
flow channel is odd-shaped, refer to Flo-Tote setup—manual on page 36.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. Click on Sensor Port[1] (FloTote).
3. Select the units in the Unit Preferences section. These units can be different from the

logged units that are specified in the Datalog Setup menu.
4. Click on the CAL WIZARD button. The Calibration Wizard window opens.
5. Select the options on each screen and click NEXT:

Option Description

Number of samples The number of times the sensor is sampled for the calibration
measurements (1, 2 or 3).

Flow parameters The shape and dimensions of the flow channel (circular, rectangular,
trapezoidal or U-shaped).

Sensor offset The difference between the measured level and the actual level.

Sediment value The amount of sediment in the flow channel.

Actual level The liquid level (depth) in the flow channel. If the sensor height was
measured indirectly, the liquid level must be measured manually.

Actual velocity The user can measure the velocity with a different instrument and enter
the value (optional).

6. When the Calibration Complete screen is shown, click FINISH. The Calibration
Wizard window closes.
Note: The Calibration Complete screen shows the values that were entered by the user and
the values that were measured by the sensor. If the values are different, the calibration
adjustment value or multiplier is shown.

7. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date time settings of the server.

4.1.4.8 Flo-Tote setup—manual
The Calibration Wizard is the easiest method to set up the sensor. Use the manual setup
for odd-shaped flow channels or to adjust some of the calibration parameters. The sensor
must be installed in the process and the connection status must be online for calibration.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. Click on Sensor Port[1] (FloTote).
3. Select the units in the Unit Preferences section. These units can be different from the

logged units that are specified in the Datalog Setup menu.
4. Click on the Flow Settings tab and select the shape of the flow channel.
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5. Enter the dimensions of the flow channel. Be sure to enter the correct depth for non-
circular channels.

6. If the flow channel is odd-shaped, a table is shown. A cross-section of the shape can
be divided into parts and the area of the parts can be entered into the table.

7. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date time settings of the server.

8. Click on the General Settings tab.
9. In the velocity settings section, click the CALCULATE button. The Site Coefficient

window opens.
10. Click TAKE SAMPLE. The velocity measurement starts. When complete, the

measured velocity is shown.
11. Measure the velocity with a different instrument and enter the value in the Actual

Velocity field. The multiplier value adjusts the sensor reading to be the same as the
actual velocity value.

12. Click OK.
13. In the level settings section, click the CALIBRATE button. The Level Calibration

window opens.
14. Click TAKE SAMPLE. The level measurement starts. When complete, the measured

level is shown.
15. Measure the liquid level manually and enter the value in the Actual Level field. The

offset value adjusts the sensor reading to be the same as the actual value.
16. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date time settings of the server.

4.1.4.9 Ultrasonic setup—Cal Wizard
Make sure to calibrate the sensor in the operating environment at the typical ambient
operating temperature. The temperature of the environment is included in calibration and
measurement calculations. The sensor has a 60 minute thermal constant over a 20 °C
(36 °F) change in temperature. Give the sensor time to adjust to a large temperature
change before calibration.
To calculate flow with level-area or head-flow tables, calibrate the sensor manually.
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Note: Only the level is calibrated unless an area velocity measurement is supplied by a velocity
sensor on a separate sensor port of the FL900 series flow logger and that sensor port is selected in
the Velocity Input field on the Flow tab.

1. Click the Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports show.

2. Select Sensor Port (US900X). The US900X Configuration screen shows.
3. In the Level Unit field, select the measurement units for the level.

Note: The level unit can be different from the logged units that are selected in the Datalog
Setup tab.

4. In the Flow Unit field, select the measurement units for the flow rate.
5. Select the options.

Option Description

Sensor Type Select the sensor type—Downlooking or In-Pipe.

Sediment Enter the level of sediment in the bottom of the channel.

Level Offset
(optional)

Enter the difference between the measured level and the actual level.
Use to correct an offset error without having to do a calibration.

6. Click CAL WIZARD. The Calibration Wizard window opens.
7. Select the options on each screen and click NEXT.

Option Description

Sensor Type Select the sensor type—Downlooking or In-Pipe.

Flow Method Select the flow calculation method—area velocity, primary device or
None. Select an area velocity option to calculate the flow rate based on
the area velocity supplied by a velocity sensor that is connected to the
flow logger. Select the type of primary device (e.g., flume or weir) to
calculate the flow rate based on the type of primary device.
Note: The ultrasonic sensor can be used as a level measurement
device only. Select None to not calculate the flow rate.

Dimensions Enter the physical parameters of the selected flow calculation method.

Velocity Input If the flow calculation method selected in the Flow Method field is an
area velocity option, select the source of the area velocity input. For
example, if an ultrasonic sensor is connected to Port 1 and a
submerged area velocity sensor is connected to Port 2, select Port 2 in
the Velocity Input field.
Note: If a primary device or None is selected in the Flow Method field,
the Velocity Input field is disabled.

Current Level Enter the flow level in the channel by direct measurement.

Number of
Measurements

Select the number of measurements to do during calibration—1, 2 or 3.
For more than 1 measurement, Flo-Ware shows the average.

If the calibration was successful, a summary of values shows:

• Distance (downlooking)—the distance from the face of the sensor to the water
surface

• Distance (in-pipe)—the distance from the sensor tube to the water surface
• Temperature—the temperature of the operating environment measured by the

sensor
• Zero Level Distance—the distance from the face of the sensor or sensor tube to

the bottom of the channel
• Echo Loss—the percentage of the ultrasonic signal that was lost during send and

receive
8. Click NEXT. "Calibration Complete" shows.
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Note: If the calibration was not successful, an error message shows and the sensor takes
another measurement.

9. Click FINISH.
10. Click WRITE TO LOGGER to save the settings. A window opens.
11. Optional: Select the options.

Option Description

Set Logger
Clock

Set the flow logger clock to the date and time setting of the computer
connected to the flow logger. If the flow logger has a modem, the flow
logger clock is set to the date and time of the server.

Erase Data Erase all the data that is kept on the flow logger.

12. Click OK.
13. Click the Flow tab that is above the Level Settings section. The values entered during

calibration show in the fields.

4.1.4.10 Ultrasonic setup—manual
The Calibration Wizard is the easiest method to set up the sensor. Use the manual setup
for sites with level-area or head-flow tables. The sensor must be installed in the process
and the connection status must be online for calibration.

1. Click the Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports show.

2. Select Sensor Port (US900X). The US900X Configuration screen shows.
3. In the Level Unit field, select the measurement units for the flow level.

Note: The level unit can be different from the logged units that are selected in the Datalog
Setup menu.

4. In the Flow Unit field, select the measurement units for the flow rate.
5. Select the options.

Option Description

Sensor Type Select the sensor type—Downlooking or In-Pipe.

Sediment Enter the level of sediment in the bottom of the channel.

Level Offset
(optional)

Enter the difference between the measured level and the actual level.
Use to correct an offset error without having to do a calibration.

6. Click CALIBRATE. The selected sensor type shows.
7. Click TAKE SAMPLE. The Distance field shows the distance measurement from the

sensor.

• Distance (downlooking)—the distance from the face of the sensor to the water
surface

• Distance (in-pipe)—the distance from the sensor tube to the water surface
8. In the Actual Level field, enter the actual measured level of the water. The Zero Level

Distance field shows the zero level.
The zero level is the distance from the face of the sensor or sensor tube to the bottom
of the channel.

9. Click OK, then OK.
10. Click WRITE TO LOGGER to save the settings. A window opens.
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11. Optional: Select the options.

Option Description

Set Logger
Clock

Set the flow logger clock to the date and time setting of the computer
connected to the flow logger. If the flow logger has a modem, the flow
logger clock is set to the date and time of the server.

Erase Data Erase all the data that is kept on the flow logger.

12. Click OK.
13. Click the Flow tab that is above the Level Settings section.
14. Select the options.

Option Description

Primary
Device

Select the flow calculation method—area velocity, primary device or None.
Select an area velocity option to calculate the flow rate based on the area
velocity supplied by a velocity sensor that is connected to the flow logger.
Select the type of primary device (e.g., flume or weir) to calculate the flow
rate based on the type of primary device.
Note: The ultrasonic sensor can be used as a level measurement device
only. Select None to not calculate the flow rate.

Dimensions Enter the physical parameters of the selected flow calculation method.

Velocity Input If the flow calculation method selected in the Flow Method field is an area
velocity option, select the source of the area velocity input. For example, if
an ultrasonic sensor is connected to Port 1 and a submerged area velocity
sensor is connected to Port 2, select Port 2 in the Velocity Input field.
Note: If a primary device or None is selected in the Flow Method field, the
Velocity Input field is disabled.

15. Click WRITE TO LOGGER to save the settings.

4.1.4.11 Ultrasonic sensor—application settings
The application settings on the Application Settings tab supply more filtering options to
manage difficult sites. For most flow conditions, the factory default settings on the
Application Settings tab are correct. Contact technical support before changes are made
to the application settings.

1. Click the Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports show.

2. Select Sensor Port (US900X). The US900X Configuration screen shows.
3. Click the Application Settings tab. Select the options.

Option Description

Filter Size Select the number of readings the flow logger takes and averages for one
data point—1–50 (default = 16).

Reject High Select the number of the highest values that are discarded—0–49.
For example, if the filter size is 16 and the reject high and reject low values
are 4, the sensor collects 16 measurements and discards the highest 4 and
the lowest 4 measurements. The other 8 values are used to calculate the
average data point of level.

Reject Low Select the number of the lowest values that are discarded—0–49.

Number of
Holds

Select the number of times the last recorded data point is saved to the log if
a failed reading occurs due to echo loss (default = 5). For example, if the
number of holds is 5, the last data point replaces the next 5 consecutive
failed readings or until a successful reading occurs.
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Option Description

Median Filter Select the number of data points that will be used in the flow logger median
filter (default = None). The flow logger takes median of 3, 5, 7, 9 or 11 data
points to decrease noise or outliers. Only the median values are logged.
Raw data values are not logged.

Sample Rate Select the number of samples taken per second—1–10 (default = 4).

Minimum
Distance

Select the minimum distance for the sensor. For the in-pipe sensor, the
default is 0. For a downlooking sensor, the default is 5.25 in. Distances less
than the minimum distance of the sensor are ignored.

Maximum
Distance

Select the maximum distance for the sensor. For the in-pipe sensor, the
default is 150.75 in. For a downlooking sensor, the default is 156.00 in.
Distances more than the maximum distance of the sensor are ignored.

4. Click WRITE TO LOGGER to save the settings.
Note: To change the configuration settings to the factory defaults, click RESTORE
DEFAULTS.

4.1.4.12 AV9000 Analyzer Module setup—Cal Wizard
The sensor can be configured and calibrated with the calibration wizard. The sensor must
be attached to the logger and online for calibration.
Note: Only the level is calibrated with the Cal Wizard. The velocity value that is shown does not
represent a velocity calibration. A calibration for velocity is not necessary, but can be completed
manually ( AV9000 Analyzer Module setup—manual on page 42).

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. Click on Sensor Port[1] (AV9000).
3. Select the units in the Unit Preferences section. These units can be different from the

logged units that are specified in the Datalog Setup menu.
4. Click on the CAL WIZARD button. The Calibration Wizard window opens.
5. Select the shape and dimensions of the flow channel (circular, rectangular,

trapezoidal or U-shaped) and click NEXT.
Note: If the flow channel is odd-shaped, refer to AV9000 Analyzer Module setup—manual
on page 42.

6. Select the type of calibration and click NEXT:

Option Description

Zero calibration in air The sensor is not installed in the flow channel.

Level adjust in flow The sensor is installed in the flow channel.

Note: It is recommended to do a zero calibration in air to get a reference each time a new
sensor is deployed or a sensor is moved to a new site. If a calibration is done in the flow, also
do a calibration in air.

7. If the sensor is installed in the flow channel, select the options on each screen and
click NEXT:

Option Description

Number of
samples

The number of times the sensor is sampled for the calibration
measurements (Enter a value between 1 and 6. Only one value is entered
regardless of the number of samples.)

Actual level The liquid level (depth) in the flow channel. If the sensor height was
measured indirectly, the liquid level must be measured manually.

8. When the Calibration Complete screen is shown, click FINISH. The Calibration
Wizard window closes.
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Note: The Calibration Complete screen shows the values that were entered by the user and
the values that were measured by the sensor. If the values are different, the calibration
adjustment value or multiplier is shown.

9. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date time settings of the server.

4.1.4.13 AV9000 Analyzer Module setup—manual
The Calibration Wizard is the easiest method to set up the sensor. Use the manual setup
for velocity calibration, odd-shaped flow channels or to adjust some of the calibration
parameters. The sensor must be online for calibration.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. Click on Sensor Port[1] (AV9000).
3. Select the units in the Unit Preferences section. These units can be different from the

logged units that are specified in the Datalog Setup menu. If the sensor is mounted
downstream in a reversed position, check "reversed sensor" to record flow with a
positive value. If applicable, enter values for sensor offset, level or allowance for
sediment in the channel.

4. Calibrate the level in the level settings section.

a. Click the CALIBRATE button. The Level Calibration window opens.
b. Click TAKE SAMPLE. The level measurement starts. When complete, the

measured level is shown.
c. Measure the liquid level manually and enter the value in the Actual Level field.

The offset value adjusts the sensor reading to be the same as the actual value.
5. Click on the Flow Settings tab and select the shape of the flow channel.
6. Enter the dimensions of the flow channel. Be sure to enter the correct depth for non-

circular channels.
7. If the flow channel is odd-shaped, a table is shown. A cross-section of the shape can

be divided into parts and the area of the parts can be entered into the table.
8. Click on the Application Settings tab.
9. Change the application settings if necessary.

Option Description

Repeat count The number of distinct target sets which are measured to determine velocity.
Six is the factory default. The user may enter other values. For values
greater than 8, a logging interval greater than one minute is necessary.
Large repeat counts will shorten the battery life. If multiple sensors are
attached, one-minute logging intervals are not recommended.
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Option Description

Delay time The time paused between the repeats to assure distinct target sets are
captured. The factory default is 2500 ms (2.5 sec). The user may enter other
values. The optimal delay time value depends on the level and velocity.

Target sets
(Target set
averaging)

Deals with velocity measurement noise caused by the non-uniform
distribution of moving targets in typical waste water flow streams. This target
noise can be reduced by averaging several readings based on distinct target
sets. There are several options for averaging:

• Robust filtering–sorts velocity readings from highest to lowest and
averages the middle values

• Reject drops–excludes outliers at low absolute velocity
• Reject spikes–excludes outliers at high absolute velocity
• Lo Freq Rej–Low Frequency Rejection may be useful to eliminate noise

in highly turbulent sites where swirling occurs at the nose of the sensor

10. Click on the Advanced Settings tab.
11. Change the application setting, if necessary.
12. If the velocity and flow are known, a site multiplier can be generated to calibrate the

velocity.

a. Click the CALCULATE button. The Velocity Multiplier window opens.
b. Click TAKE SAMPLE. The velocity measurement starts. When complete, the

measured velocity is shown.
c. Measure the velocity with a different instrument and enter the value in the Actual

Velocity field. The multiplier value adjusts the sensor reading to be the same as
the actual velocity value.

d. Click OK.
13. Change any of the settings for velocity if necessary:

Option Description

Site Multiplier The value that adjusts the sensor velocity reading to be the same as the
velocity reading from a different instrument. If not sure, use the default value
of 1.0.

Low Level
Cutout

Forces the velocity to a substitute value when the level measurement is
below a user-specified value. The factory default is enabled at 0.8 inches.

Substitute
Velocity

The value of the substitute velocity (typically 0).

Filter Size Select the type of filter and the filter size (factory default is none). Takes the
average and/or median of 3, 5, 7, 9 or 11 data points to reduce noise or
outliers. Only the average and/or median values are logged—raw data
values are not logged. A significant delay can occur before sudden changes
in flow are logged, therefore this option is not recommended for stormwater
applications.

Salinity Select wastewater, salt water or enter a user defined value. Factory default
is wastewater.

Device communication

43



Option Description

Analyzer
Settings

Doppler Min/Max. Useful to remove noise from turbulent sites. This sets
velocity limits based on the FFT defined in Hz. It is recommended to contact
Tech Support for FFT evaluation and recommendation.

Diagnostic
Mode

Use this mode to capture details useful when troubleshooting with Tech
Support. To run diagnostics, go to Diagnostics tab, Sensors, select time
series (1 hour, 1 day or 1 week) and Run Diagnostics. Diagnostics will be
recorded for the specified time frame.

• Normal–Factory default setting.
• Asym Spectra–Assymetrical Spectra. Allows comparison of remaining

spectra after mirror image is removed.
• Extend Spectra–Allows a detailed view of the noise floor of "best scale."
• Extend All–Similar to Extend Spectra, but of all scales.
• Time Series–Time series sub-measurement data only up to

32 readings.
• Combination–Time series (up to 20 points) plus "Normal". Allows

viewing of sub-measurements based on repeat count.

14. Click WRITE TO LOGGER if connected to logger to save the settings, or click SAVE
PROGRAM TO FILE to create a template. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date and time settings of the server.

15. Change any of the settings for level if necessary.
16. For help with difficult sites and additional diagnostic tools, contact Hach Flow Tech

support to assist with diagnostics on the TECH SUPPORT SETTINGS tab.

4.1.4.14 IM9001 module setup
The IM9001 interface module allows the logger to collect data from an attached Sigma
Flow Meter and transmit the data via a wireless or local connection. The data can be
used to trigger alarms or pace a sampler. The module can also be used as a network
interface for Modbus communication (Modbus communication on page 51).
Use the Datalog Setup menu to set the log intervals and to select the channels that are
logged (Datalog setup on page 29). The logging intervals that are programmed into the
950 Flow Meter must be greater than or equal to the logging intervals of the logger to be
sure that all data is logged.
Note: The Sigma Flow Meter program cannot be configured through the IM9001 module. The Flow
Meter must be programmed with either Flow Center software or the keypad on the Flow Meter
before connection to the IM9001 module. Refer to the Sigma User Manual for programming details.
The logger program and Sigma Flow Meter programs run independently of each other.

The IM9001 module must be configured to communicate with a Sigma Flow Meter.

1. Click on the Programming tab in the FL900 Series Driver window. If online, the
attached sensors and ports are shown.

2. If offline, click on the Datalog Setup menu. Select the sensor(s) from the drop-down
list in the Port Assignments section that agree with the sensor and port configurations
on the logger.

3. Click on Sensor Port[1] (IM9001).
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4. Change any of the options:

Option Description

Modbus Address This setting must match the Modbus address that is programmed into the
Sigma Flow Meter.

Baud Rate This setting must match the Baud rate that is programmed into the Sigma
Flow Meter.

5. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date time settings of the server.

4.1.4.15 Set up alarms
Use the Alarms menu to set up channel alarms, system alarms and notifications.
Channels must first be selected in the Datalog Setup menu before channel alarms can be
set. A maximum of 16 channel alarms can be set.

1. Click the Programming tab.
2. Click on the Alarms menu.
3. To set a channel alarm, click on the Channel Alarms tab:

a. Click on the ADD ALARM button.The Add Channel Alarm window opens.
b. Select the channel from the drop-down list.
c. Select the type of alarm (low/low, low, high, high/high) and click OK. The channel

alarm is shown in the main section.
d. Enter the trigger value and deadband. An alarm starts when the channel value is

equal to the trigger value. An alarm stops when the channel value goes above
(low alarm) or below (high alarm) the deadband value.

Figure 9  Low alarm example

1   Channel value 3   Low alarm stops 5   Trigger value

2   Low alarm starts 4   Deadband 6   Time
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e. Select the actions that will start during an alarm condition:

Option Description

Send SMS from logger Send an SMS (text) message from the logger—useful when
the server cannot be contacted.

Send Email from logger Send an email message from the logger—useful when the
server cannot be contacted.

Trigger sampler When a sampler is attached, start a sampling program.

Switch to secondary log
interval

Switch to secondary log interval—the secondary log interval
is used.

Switch to secondary call
interval

Switch to secondary call interval—the secondary call
interval is used.

Send SMS from server Send an SMS (text) message from the server—saves
battery power on the logger.

Send Email from server Send an email message from the server—saves battery
power on the logger.

4. To set a system alarm, click on the System Alarms tab:

a. Select the system alarm type:

Option Description

Low Main Power The batteries in the logger or external power supply is less than
8 V.

Low RTC Battery The battery for the internal clock in the logger is weak.

Low Slate Memory The datalog is 80% full.

Slate Memory Full The datalog is full and data collection has stopped.

Sensor Timeout The sensor has not responded to a call by the server.

Sensor ID Error The program cannot detect what type of sensor is connected.

b. Select the system alarm actions:

Option Description

Send SMS from logger Send a text message from the logger via the network provider.

Send Email from logger Send an email from the logger via the network provider.

Send SMS from server Send a text message from the FSDATA server.

Send Email from server Send an email from the FSDATA server.

5. To set enter recipient information for alarm notifications, click on the Recipients tab:

a. Enter the email address for each email recipient (maximum of 5).
b. Enter the number for each SMS (text message) recipient (maximum of 5).

4.1.4.16 Set sampler options
If a sampler is used, the sampler must be attached to the auxiliary port on the logger. Use
the Sampler menu to specify when samples are taken.

1. Click the Programming tab.
2. Click on the Sampler menu.
3. In the Pacing Source field, select the sensor port that will measure flow for the

sampler.
4. Enter the volume interval that generates a flow pulse to the sampler. For example, a

sampler can take a sample every 100 gallons of flow.
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Note: The sampler can also take a sample during alarm conditions if the Trigger sampler
action is set for a channel alarm.

4.1.5 View data

4.1.5.1 Download data
When data is downloaded from the logger, the data includes the channel data, the event
log, the alarm log and the sample history. The data is automatically saved as a .fl9 file in
the default file path.

1. Open a communication session with the logger (Connect to the logger on page 25).
2. Click on one of the download options:

Option Description

Download all of the data from the logger.

Download only the data that was logged since the last download.

3. Wait for the data to download. When complete, a confirmation message is shown.
Click OK. The data is shown in the FL900 window ( Tabular view on page 47).

4.1.5.2 Open a site file
Data files that were downloaded previously can be opened when the connection status is
offline.

1. Make sure the connection status is offline. If online, click on the DISCONNECT
button.

2. Click on the OPEN A SITE FILE button. The Open file window opens.
3. Find the file and click OPEN. The data is shown in the FL900 window ( Tabular view

on page 47).

4.1.5.3 Tabular view

The tabular view shows the data in a spreadsheet format (Figure 10). The following
options are available:

Option Description

Open in Flo-Ware Click on the Flo-Ware icon to open the file in the main Flo-Ware
application

Sort data Click on a column header to sort the data by that column

Show or remove
channels

Click on the check box next to a channel and click the UPDATE
TABLE button to show or remove channels.

Change the date range Change the date and time range and click the UPDATE TABLE button.

Copy to the clipboard Click on the copy icon to copy the data to the clipboard. The data can
then be pasted in a spreadsheet or other application.

Print Click on the printer icon to send the data to a printer.

Export as tab-
separated

Click on the TSV icon to export the data as a tab-separated file.
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Option Description

Export as comma-
separated

Click on the CSV icon to export the data as a comma-separated file.

Open in Excel Click on the Excel icon to open the data in Microsoft® Excel®

spreadsheet software.

Figure 10  FL900 tabular data view

4.1.5.4 Graph view

The graph view shows the data in a line graph (Figure 11). A maximum of 2 channels can
be shown. The rain gauge and sampler are shown as bars in addition to the 2 selected
channels. The bars for the sampler are shown in a green color when a sample was
collected and in a red color if the sampler failed to collect a sample.
The following options are available:

Option Description

Show or remove
channels

Click on the check box next to a channel and click the UPDATE TABLE
button to show or remove channels.

Change the date range Change the date and time range and click the UPDATE TABLE button.
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Option Description

Copy to the clipboard Click on the copy icon to copy the data to the clipboard. The data can
then be pasted in a spreadsheet or other application.

Print Click on the printer icon to send the data to a printer.

Export as image Click on the BMP icon to save the graph in a .bmp image format.

Zoom in Click on the graph and drag to the right to zoom in.

Zoom out Click on the graph and drag to the left to zoom out.

Pan left, right, up or
down

Right-click on the graph and drag to the left, right, up or down to move
the graph position.

Figure 11  FL900 graph view

4.1.5.5 Sample log

When a sampler is attached to the logger, the following sample data is collected and
shown in the tabular format:

• Date and time of the sample
• Sample status (success or failed)
• Sample number
• Sample bottle number
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Refer to the Tabular view on page 47 for a description of the available user options.

4.1.6 Troubleshooting

4.1.6.1 View diagnostic information
The user can view diagnostic information to help solve a problem or to confirm normal
operation.

1. Click on the Diagnostics tab.
2. Select one of the menu options:

Option Description

Event Log The date and time, event number, event text and event data is shown for all
events in the tabular format. Refer to the Tabular view on page 47 for a
description of the available user options.

Current
Status

When online, real-time general information such as the power supply voltage is
shown. The measured channel values are shown and are updated at the same
interval that is set in the logger program. If a sampler is connected, the volume
before the next sample is taken is shown.

Sensors When online, the user can download a sensor diagnostic file (.sdf) for use by
technical support. The file is saved in the location that is specified in the
settings. Technical support may ask the user to take a sample or to run
diagnostics for a specified time (1 hour, 1 day or 1 week) to get additional
diagnostic information.

Modem When online, information about the modem and the signal strength is shown.
The registration status should show home. The CALL SERVER button can be
used to connect to the server and to show connection information. When the
call is complete, click the SAVE button to save the information.

Alarm Log The data for all alarms is shown in the tabular format. Refer to the Tabular view
on page 47 for a description of the available user options.

4.1.6.2 Manual USB driver installation
If there was a problem with the USB driver installation, install the USB driver manually.

1. With the logger attached to the PC, open the Windows Device Manager.
2. Find the FL-9XX port under the Ports node and open the port properties.
3. Install the driver from C:\Program Files\Flo-Ware\FL9xx\Backup (file name:

FL-9XX_USB.inf).

4.1.6.3 Restore factory settings
If necessary, the user program in the logger can be replaced with the factory settings.

1. Make sure that the logger is attached to the computer and that the connection status
is online.

2. Click on the Utilities tab.
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3. Select the Restore Factory Settings option.
4. Click WRITE TO LOGGER to save the settings. A message window is shown:

Option Description

Warning: all data
will be lost.
Continue?

All data that is stored in the logger is erased when a program is written to
the logger. To save the data, select No and download the data to a safe
location. Select Yes to erase all data and update the logger with the new
program.

Set Logger Clock Synchronize to Computer Clock—the logger uses the date and time
settings of the computer. Set Logger Clock—the logger uses the date
and time settings that are set by the user. If the unit has a modem, the
logger automatically uses the date time settings of the server.

4.1.7 Update the firmware
The firmware is updated regularly for continued improvement. Install the updates for best
results.

1. Click on the Utilities tab and select the Firmware Update menu.
2. Select the file to install.
3. Click START.
4. Select the udpate option and click OK. The update starts. Wait for the status to show

complete.

4.1.A Modbus communication

4.1.A.1 Overview
The Modbus protocol can be used for communication with the FL900 Series Loggers. An
external network device such as a PLC can attach to the logger and read data as it is
logged. Historical data cannot be read.
The Modbus information that follows assumes that the network device is attached to the
RS232 interface on the logger.

4.1.A.2 Communications setup
An RS232 communication cable must be used to attach the logger to an external network
device such as a PLC. Refer to the user manual for the FL900 Series Flow Logger for
detailed information.
The communication settings can be changed with Flo-Ware. Refer to Communications
settings—local on page 27. Table 3 shows the default settings and options for each
setting.
The logger supports various frame sizes based on the Modbus protocol and parity setting.
The parity setting can be modified using Flo-Ware, thereby setting the frame size of the
communication hardware. The following frame sizes are supported by the logger:
Modbus RTU

• 8 bits, even parity, 1 stop bit
• 8 bits, odd parity, 1 stop bit
• 8 bits, no parity, 2 stop bit

Modbus ASCII

• 7 bits, even parity, 1 stop bit
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• 7 bits, odd parity, 1 stop bit

Table 3  Communication settings

Setting Default Options

Protocol Modbus RTU Modbus RTU or Modbus ASCII

Address 2 1–247; also responds to broadcast address 0 

Baud rate 115200 9600, 19200, 38400, 57600, 115200 

Frame size 8 bits, no parity, 2 stop bits Modbus RTU: 8 bits, even parity, 1 stop bit; 8 bits, odd parity, 1 stop bit; 8 bits, no
parity, 2 stop bits

Modbus ASCII: 7 bits, even parity, 1 stop bit; 7 bits, odd parity, 1 stop bit

4.1.A.3 Communication with the logger
The logger hardware makes use of transmit, receive, and signal ground signals on the
RS232 interface. The logger responds to Modbus queries that match the assigned
address as well as broadcast address 0. When address 0 is used, the master does not
know the logger address, which facilitates peer-to-peer communications on a bus with
one master and no other slaves. FloWare can be used to change the Modbus address
setting in the FL900.

4.1.A.3.1 Communication timeouts
Minimum and maximum response times are used for reliable exchanges with the Modbus
master and to prevent collisions on the RS232 bus. The minimum response time is the
wait time before a reply is sent to a Modbus query (default: 30 ms). The maximum
response time is the total time that is allowed for a reply to be sent to a Modbus query
(default: 1 second).
If a reply cannot be sent within the maximum response time, a timeout occurs. The logger
stops processing and prepares for the next Modbus query. The timeout value cannot be
modified.

4.1.A.3.2 Sleep modes
Sleep modes are used to extend the battery life of the logger. After 5 seconds of idle time
on the RS232 bus, the RS232 interface on the logger closes. To keep the
RS232 interface open, a valid Modbus command must be sent to the logger in intervals of
< 5 seconds.
If the RS232 interface is closed, a sacrificial Modbus command must be sent to the logger
to open the interface. This command serves only to open the interface. No response is
made to the sacrificial Modbus command.
If the logger has not shut down at least once in a 3-hour period, a soft reset automatically
occurs.

4.1.A.4 Modbus registers
The logger program that is set up by the user shows which measurements are associated
with each datalog channel (refer to Datalog setup on page 29). Each datalog channel in
the logger is mapped to a Modbus measurement register. If a new program is written to
the logger, the user-selected measurements are automatically mapped to the 16 available
datalog channels.
Each Modbus measurement register is associated with two Modbus description registers.
The description registers, A and B, add additional details about the measurement value.
Each Modbus measurement register reads data as it is currently logged. For example, if
an attached sensor has a primary logging interval of 5 minutes, the corresponding
Modbus register shows the updated data every 5 minutes.

4.1.A.4.1 Register configuration
FloWare is used to generate the Modbus register map from the datalog channel
configuration in the logger program. The register map is generated online when
connected to a logger or offline using a previously downloaded site file. The map can be
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printed, exported to a spreadsheet or copied to the clipboard. If the datalog channel
configuration changes, the modbus map changes, and a new Modbus map should be
generated.
To generate the map, open the FL900 Series driver in FloWare, select the Utilities tab
and then select Modbus Map. The Modbus map is shown for the datalog channel
configuration that is current. An example of a Modbus map is shown in Figure 12.

Figure 12  Example Modbus map for logger program

4.1.A.4.2 Register order
The data order in the logger registers is big-endian with the most significant byte first,
followed by the least significant byte second. The register order for multi-register numeric
values (floats and integers) is little endian. If a different ordering scheme is needed, the
data must be processed externally.

4.1.A.4.3 Measurement registers
The logger implements 16 Modbus measurement registers, where each register maps
directly to 1 of 16 data log channels. One or more measurement registers can be read
with Modbus Function Code 03 Read Holding Registers. Refer to Table 4.
The definition of each data log channel is made when a user changes the data log
configuration and programs the logger. To know what each measurement register
represents, the user has two options. The first option is for applications where the logger
is connected to an external device that is manually configured by the user. The second
option is for applications where the logger is connected to an external device that is
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capable of automatic configuration with the use of additional measurement description
registers that are supplied by the logger.

Table 4  Modbus measurement registers

Register Number Data Type Read/Write Name Data Map

40013-40014 4 byte float Read Measurement Register 1 Data Log Channel 1 

40015-40016 4 byte float Read Measurement Register 2 Data Log Channel 2 

40017-40018 4 byte float Read Measurement Register 3 Data Log Channel 3 

40019-40020 4 byte float Read Measurement Register 4 Data Log Channel 4 

40021-40022 4 byte float Read Measurement Register 5 Data Log Channel 5 

40023-40024 4 byte float Read Measurement Register 6 Data Log Channel 6 

40025-40026 4 byte float Read Measurement Register 7 Data Log Channel 7 

40027-40028 4 byte float Read Measurement Register 8 Data Log Channel 8 

40029-40030 4 byte float Read Measurement Register 9 Data Log Channel 9 

40031-40032 4 byte float Read Measurement Register 10 Data Log Channel 10 

40033-40034 4 byte float Read Measurement Register 11 Data Log Channel 11 

40035-40036 4 byte float Read Measurement Register 12 Data Log Channel 12 

40037-40038 4 byte float Read Measurement Register 13 Data Log Channel 13 

40039-40040 4 byte float Read Measurement Register 14 Data Log Channel 14 

40041-40042 4 byte float Read Measurement Register 15 Data Log Channel 15 

40043-40044 4 byte float Read Measurement Register 16 Data Log Channel 16 

4.1.A.4.4 Description registers
Two description registers, A and B, are associated with each individual Modbus
measurement register (Table 5). The Modbus description registers allow third parties to
develop external devices that have plug and play capabilities with the FL900 logger and
minimize manual setup by the end user. Each description register can be queried by an
external device to get more details about the measurement value.

Table 5  Modbus description registers

Register number Data type Read/Write Name

40213-40214 4-byte Unsigned Read Measurement 1 Description Register. 'A'

40215-40216 4-byte Unsigned Read Measurement 1 Description Register. 'B'

40217-40218 4-byte Unsigned Read Measurement 2 Description Register. 'A'

40219-40220 4-byte Unsigned Read Measurement 2 Description Register. 'B'

40221-40222 4-byte Unsigned Read Measurement 3 Description Register. 'A'

40223-40224 4-byte Unsigned Read Measurement 3 Description Register. 'B'

40225-40226 4-byte Unsigned Read Measurement 4 Description Register. 'A'

40227-40228 4-byte Unsigned Read Measurement 4 Description Register. 'B'

40229-40230 4-byte Unsigned Read Measurement 5 Description Register. 'A'

40231-40232 4-byte Unsigned Read Measurement 5 Description Register. 'B'

40233-40234 4-byte Unsigned Read Measurement 6 Description Register. 'A'

40235-40236 4-byte Unsigned Read Measurement 6 Description Register. 'B'

40237-40238 4-byte Unsigned Read Measurement 7 Description Register. 'A'
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Table 5  Modbus description registers (continued)

Register number Data type Read/Write Name

40239-40240 4-byte Unsigned Read Measurement 7 Description Register. 'B'

40241-40242 4-byte Unsigned Read Measurement 8 Description Register. 'A'

40243-40244 4-byte Unsigned Read Measurement 8 Description Register. 'B'

40245-40246 4-byte Unsigned Read Measurement 9 Description Register. 'A'

40247-40248 4-byte Unsigned Read Measurement 9 Description Register. 'B'

40249-40250 4-byte Unsigned Read Measurement 10 Description Register. 'A'

40251-40252 4-byte Unsigned Read Measurement 10 Description Register. 'B'

40253-40254 4-byte Unsigned Read Measurement 11 Description Register. 'A'

40255-40256 4-byte Unsigned Read Measurement 11 Description Register. 'B'

40257-40258 4-byte Unsigned Read Measurement 12 Description Register. 'A'

40259-40260 4-byte Unsigned Read Measurement 12 Description Register. 'B'

40261-40262 4-byte Unsigned Read Measurement 13 Description Register. 'A'

40263-40264 4-byte Unsigned Read Measurement 13 Description Register. 'B'

40265-40266 4-byte Unsigned Read Measurement 14 Description Register. 'A'

40267-40268 4-byte Unsigned Read Measurement 14 Description Register. 'B'

40269-40270 4-byte Unsigned Read Measurement 15 Description Register. 'A'

40271-40272 4-byte Unsigned Read Measurement 15 Description Register. 'B'

40273-40274 4-byte Unsigned Read Measurement 16 Description Register. 'A'

40275-40276 4-byte Unsigned Read Measurement 16 Description Register. 'B'

4.1.A.4.4.1 Description register formats
Two formats, A and B, are used by the description registers to give measurement details.
Refer to Figure 13 and Figure 14.

Figure 13  Description register format A

Figure 14  Description register format B

4.1.A.4.4.2 Parameter field
The parameter field shows what the measurement represents (Table 6).

Table 6  Parameter field descriptions

Returned value Parameter

0 FL900 series power supply

1 Modem signal strength

2 Modem signal quality

3 Flow

4 Level
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Table 6  Parameter field descriptions (continued)

Returned value Parameter

5 Velocity

6 Temperature

7 Surface velocity

8 Distance

9 Minimum distance

10 Maximum distance

11 Distance reading Count

12 Surcharge level

13 PMR

14 NOS

15 Conductivity

16 Surcharge velocity

17 Gain

18 Measurement Flag

19 Rain

20 Raw level

21 pH/ORP

22 Channel 1

23 Channel 2

24 Channel 3

25 Channel 4

26 Channel 5

27 Channel 6

28 Channel 7

29 Best scale

30 Bins

4.1.A.4.4.3 Sensor type field
The sensor type field shows the type of sensor that made the measurement (Table 7).

Table 7  Sensor type field description

Returned value Sensor type

1 Not detected

3 Logger

4 FloDar

5 FloTote

6 SVS

7 AV9000 
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Table 7  Sensor type field description (continued)

Returned value Sensor type

8 IM9001

9 US900X

4.1.A.4.4.4 Data source field
The data source field shows whether the measurement came directly from the logger or
from one of the sensor ports on the logger (Table 8).

Table 8  Data source field description

Returned value Data source

0 Logger

1 Sensor Port 1 

2 Sensor Port 2 

3 Sensor Port 3 

4 Sensor Port 4 

4.1.A.4.4.5 Log interval fields
The primary, secondary and current logging interval fields can be queried to show which
logging interval is in use. An external device can use this information to optimize the
polling interval. The log interval values are returned in minutes.
Dynamic logging occurs with the primary and secondary logging intervals. The primary
logging interval is used during normal operation. If an alarm condition occurs, the log rate
automatically changes to use the secondary logging interval. When operation returns to
normal, the log rate automatically changes to use the primary logging interval again. For
more information refer to Set up alarms on page 45.

4.1.A.4.4.6 Base unit field
The base unit field shows the base unit of measure for the measurement regardless of
the selected user preference. Table 9 includes units that may not be applicable at this
time.

Table 9  Base unit field description

Returned value Unit of measure

0 mg/L (milligrams per liter)

1 g/L (grams per liter)

2 ppm (parts per million)

3 mE (milliextinction)

4 E (extinction)

5 1/m (per meter)

6 FNU (formazin nephelometric unit)

7 NTU (nephelometric turbidity unit)

8 TE/F (German formazin nephelometric unit)

9 EBC (European brewery congress)

10 % (percent)

11 nm (nanometer)

12 mm (millimeter)
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Table 9  Base unit field description (continued)

Returned value Unit of measure

13 m (meter)

14 msec (milliseconds)

15 sec (seconds)

16 min (minutes)

17 hrs (hours)

18 mA (milliamps)

19 mV (millivolts)

20 mNTU (milliNTU)

21 mFTU (milliFTU)

22 mTE/F (milliTE/F)

23 m % (millipercent)

24 Counts

25 C (degrees Celsius)

26 F (degrees Fahrenheit)

27 pH

28 mV/pH (millivolts per pH unit)

29 uA (microamperes)

30 L/h (liters per hour)

31 ppt (parts per thousand)

32 S/cm (Siemens per centimeter)

33 Ohm/cm (ohms per centimeter)

34 S/m (Siemens per meter)

35 Ohm/m (ohms per meter)

36 kOhm (kiloohm)

37 MOhm (megaohm)

38 ppb (parts per billion)

39 ug/L (micrograms per liter)

40 sat (saturation)

41 mFNU (milliFNU)

42 FTU (formazin turbidity unit)

43 ft (feet)

44 deg (degrees angle or phase)

45 mmHg (millimeters of mercury)

46 inHg (inches of mercury)

47 torr

48 pH/C (pH per degree C)

49 day (day)
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Table 9  Base unit field description (continued)

Returned value Unit of measure

50 uS/cm (microSiemens per centimeter)

51 mS/cm (milliSiemens per centimeter)

52 Ohm

53 %/C (percent per degree C)

54 ppm/uS (ppm per uS )

55 mMol/L (millimole per liter)

56 kOhm/cm (kiloohm per centimeter)

57 MOhm/cm (mega ohm per centimeter)

58 mS/m (milliSiemens per meter)

59 uS/m (microSiemens per meter)

60 degree

61 BAR (bar)

62 kPa

63 Pa

64 psi (pressure per square inch)

65 psia

66 psig

67 gpm (gallons per minute)

68 gps (gallons per second)

69 gph (gallons per hour)

70 mgd (million gallons per day)

71 Lps (liters per second)

72 Lpm (liters per minute)

73 Lph (liters per hour)

74 m3/sec (cubic meters per second)

75 ft3/sec (cubic feet per second)

76 m/s (meters per second)

77 fps (feet per second)

78 cm (centimeters)

79 ft (feet)

80 in. (inches)

81 m (meters)

82 volts

83 AU (Absorbtion unit)

84 nA (nanoampere)

85 nA/ppm (nanoampere per ppm)

86 uA/ppm (microampere per ppm)

Device communication

59



Table 9  Base unit field description (continued)

Returned value Unit of measure

87 nA/mg (nanoampere per mg)

88 uA/mg (microampere per mg)

89 Sal (salinity)

90 gal (gallons)

91 ltr (liters)

92 %[1cm] (% transmission in 1-cm path)

93 m3/h (cubic meters per hour)

94 gpd (gallons per day)

95 mL (milliliters)

96 af (acre feet)

97 cf (cubic feet)

98 m3 (cubic meters)

99 cm2 (square centimeters)

100 ft2 (square feet)

101 in2 (square inches)

102 m2 (square meters)

103 afd (acre feet per day)

104 cfm (cubic feet per minute)

105 cfh (cubic feet per hour)

106 cfd (cubic feet per day)

107 cmm (cubic meters per minute)

108 cmd (cubic meters per day)

109 g/kg (grams per kilogram)

110 mils (1/1000 inch)

111 %H2S

112 %LEL

113 VDC

114 no unit

115 Hz (Hertz)

116 kHz (kiloHertz)

117 mL/L (milliliters per liter)

118 mL/g (milliliters per gram)

119 MHz (megaHertz)

120 ft3/min (cubic feet per minute)

121 ft3/h (cubic feet per hour)

122 m3/min (cubic meters per minute)

123 m3/day (cubic meters per day)
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Table 9  Base unit field description (continued)

Returned value Unit of measure

124 L/day (liters per day)

125 af/h (acre-feet per hour)

126 mL/day (milliliters per day)

127 mg/L-N (milligrams per liter as Nitrogen)

128 K (degrees Kelvin)

129 %660nm (transmission percent at 660 nm)

130 v660nm (transmission voltage at 660 nm)

132 mS (milliSiemens)

133 uS (microSiemens)

134 %O2 (percent oxygen)

135 uE/S/m2

136 Kg/L

137 ft3/day

138 ft3

139 mg (million gallons)

140 cfs (cubic feet per second)

141 cms (cubic meters per second)

142 cmh (cubic meters per hour)

143 Unknown
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